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Additional Resources
In addition to these Release Notes and HTML Help, Tecplot 
360 includes access to the following online forum and eight 
manuals to help you explore all of Tecplot 360’s functionality.

• Getting Started Manual Your introduction to Tecplot 
360, including tutorials that will help you learn your 
way around.

• User’s Manual This manual provides a complete 
description of working with Tecplot 360 features.

• Scripting Guide This guide provides Macro and 
Python command syntax and information on working 
with Macro and Python files and commands.

• Quick Reference Guide This guide provides syntax for 
zone header files, macro variables, keyboard shortcuts, 
and more.

• Data Format Guide This guide provides information 
on outputting simulator data to Tecplot 360 file format.

• Add-on Developer’s Kit - User’s Manual This manual 
provides instructions and examples for creating add-
ons for Tecplot 360.

• Add-on Developer’s Kit - Reference Manual This 
manual provides the syntax for functions included in 
the add-on kit.

• Installation Guide These instructions give a detailed 
description of how to install Tecplot 360 on your 
machine.

• Tecplot Talk A user-supported forum discussing 
Tecplot 360, Tecplot Focus, Python scripting, Add-on 
development, TecIO and more. Visit 
www.tecplottalk.com for details.

http://www.tecplottalk.com
http://www.tecplottalk.com
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Welcome to Tecplot 360 2011 R2

Welcome to Tecplot 360 2011 Release 2! This release includes 
significant enhancements to performance and 
responsiveness, updated data file format support, and a few 
new features based on customer requests.

A Tecplot 360 2011 license key is required to run this release.

What’s New
• Performance and Responsiveness Enhancements

Loading data in the most popular formats is now 
significantly faster and provides better progress 
information, so Tecplot 360 does not seem to “lock up” 
when loading large files. Performance of some other 
common operations (including slicing, calculate-on-
demand in the Analyze tools, and animation) has also 
been improved, and more parts of Tecplot 360 will use 
multiple processors when available.

• New Linux Support
Red Hat Enterprise Linux (RHEL) 6 and SUSE Linux 
Enterprise Desktop (SLED) 10 are now supported and 
tested platforms for Tecplot 360. (See the RHEL 6 font 
note under Platform-Specific Issues.)

• CGNS Loader Enhancements
The CGNS Loader now supports CGNS 3.1, loads 
Global Convergence History, line segment zones with 
mixed elements, HDF5 formatting, 

• PLOT3D Loader Enhancements
The PLOT3D loader can now append solution variables 
to existing zones and can extract solution time from 
filenames.
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• FEA Loader Enhancements
The FEA loader can now open OpenFOAM files and 
ANSYS 13.0 files. The Post Processing dialog is now 
automatically opened when appropriate instead of 
being a manual step.

• Set Initial Velocity in Particle Path Calculations
Initial particle velocity can now be specified in a 
particle path calculation (Analyze > Calculate Particle 
Paths and Streaklines). Previously, it was defined as 
either the local flow velocity or zero velocity. Click the 
Particles Have Mass checkbox and then open the Mass 
Options dialog.

• Prototype Pick and Change Add-On
A new add-on allows data to be quickly altered or 
blanked based on 2D or 3D geometries. This add-on is 
disabled by default. To enable it, put the following line 
in your tecplot.add file: 
$!LoadAddon "tecutiltools_pickalter"

• Regular Expressions in Select By Name Dialog
Zones and variables can now be selected using regular 
expressions in the Tecplot 360 user interface.

• Fourier Transform Usability Enhancements
The Fourier Transform function can re-use existing 
variables rather than creating new ones each time.

• Better Handling of Solution Time in Style Sheets
When loading a style sheet, Tecplot 360 used to 
complain if the current data set did not have a time step 
with the solution time stored in the style sheet, and did 
not apply the style sheet. This limited the usefulness of 
style sheets to data sets which were nigh-identical to 
the one used to create the style sheet. Now, Tecplot 360 
simply selects the time step closest to the solution time 
stored in the style sheet and applies the saved styles to 
this time step.
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What Was New in Tecplot 360 2011
Tecplot 360 2011 R2 also includes the following changes that 
originally made their appearance in Tecplot 360 2011 earlier 
this year.

• Integration by Time Strand
Integration can now be performed by time strands as 
well as by zones. This allows, for example, mass flow to 
be calculated and plotted at the various time steps of 
your data set.

• Fourier Transform
The Fourier transform feature (accessible through 
Data>Fourier Transform) allows you to transform one-
dimensional ordered linear data into the frequency 
domain for visualization and further analysis.

• Marker Gridlines
XY and Polar line plots now offer a marker gridline in 
addition to the major and minor gridlines. The marker 
gridline can be positioned at a constant value or at the 
solution time. Both the Time Series plot and CFDA 
Integration plot now utilize this feature.

•  3D Multi-Frame Add-On
The 3D Multi-Frame add-on makes it easier to tile 
frames and to get simultaneous top/front/side views of 
3D frames. These functions are available from the 
Frame menu.

• Loader Updates
The CGNS loader can now load multiple files and 
supports versions up to 3.1. It can also load rigid grid 
motion data and line segment zones andnow  supports 
HDF5 file structure in addition to ADF.
The FLOW-3D loader supports FLOW-3D/MP 4.1. 
The HDF5 loader has been updated to use version 1.8.5 
of the HDF5 library. 
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The PLOT3D loader can now load multiple overset files 
and files larger than 2GB.
The Fluent loader is now significantly faster on many 
files, particularly those that contain large amounts of 
data that Tecplot 360 does not use.
The ABAQUS loader now supports version 6.10.
The StarCCM loader is no longer supported. Instead, 
simply export in Tecplot format from StarCCM.

• New Video Export Formats
Tecplot 360 can now export animations in Windows 
Media Video (WMV), MPEG-4, and Flash Video (FLV) 
formats.

• Visual Improvements
A number of new color maps are provided with Tecplot 
360 2011, including diverging, sequential, and 
qualitative maps based on cartographic principles, as 
well as elevation (with or without water), Doppler, 
magma, hot metal, and more.
The default colors assigned to lines, symbols, and other 
objects in XY and Polar Line plots have been revised to 
improve the visibility of items that had previously been 
colored cyan (light blue) and yellow. These are now 
colored dark gray and orange, respectively.
Finally, the default symbol shape for particle paths and 
streaklines is more visible.

• Integrated Solution Time Linking
You can link the solution time between frames in the 
Frame Linking dialog. This capability is now a part of 
the core Tecplot 360 product, not an add-on.

• Intelligent Filename Sorting
When selecting more than one file to be opened in a 
multi-select dialog, the files are now sorted in an order 
that considers numbers in the filenames, so that e.g. 
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“a800.plt” is always loaded before “a1000.plt”. 
Previously, load order was dependent on the order files 
were clicked in the dialog and was not always clear.

• Solution Time Preserved in Viewer Files
When exporting a Tecplot viewer file (.lpk), the solution 
time of the exported time step is included in the file.

• Unicode Improvements on Linux and Mac OS X
Library upgrades now allow more platforms, including 
recent Linux distributions and Mac OS X versions, to 
take advantage of the Unicode text support introduced 
in Tecplot 360 2010.
Your X Server must be using a Unicode font to see 
extended characters in Tecplot 360’s interface controls. 
The xlsfonts shell command can be used to determine 
which X fonts support Unicode (fonts whose name 
contains “iso10646” are Unicode fonts). To have your X 
server automatically select a Unicode font while 
running Tecplot 360, edit the fontList line in app-
default/Tecplot130 as follows:
Tecplot*fontList:           -*-*-medium-r-*-*-12-*-*-*-*-*-iso10646-*

If your operating system does not allow you to enter 
Unicode text in Tecplot 360’s dialogs, you may need to 
edit layouts or use macros to use non-ASCII text.

• Prototype Feature Add-Ons
Two new feautures, Distribution Plots and Compare XY 
Maps, are provided in prototype form for your 
feedback. 
The Distribution Plots add-on produces histogram and 
cross plots for 3D and 2D Cartesian frames. This add-
on is available from the Tools menu.
The Compare XY Maps add-on produces various types 
of comparison plots between line maps in XY plots, 
including delta, variance, average, sum, standard 
deviation, minimum, and maximum. This add-on is 
available from the Data menu.
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These add-ons are not loaded by default. To activate 
them, remove the # symbol from the beginning of the 
following lines in your tecplot.add file:
#$!LoadAddon "histogram"      # Distribution Plots
#$!Loadaddon "companalysis"   # Compare XY Maps

Remote Display
Linux and UNIX systems (including Mac OS X) can use 
X Windows to display Tecplot 360 on a separate system 
from the one on which Tecplot 360 is actually running. 
Your X display software must support the GLX 
OpenGL Extensions, or you must have the graphics 
rendered by the host CPU using the Mesa software 
renderer.
On Windows systems you must use the included 
Remote Desktop Connection software, which transmits 
the entire user interface to a remote computer. This 
allows the rendering to be performed in hardware on 
the host computer and the results transmitted across 
the network. Similar options are also available for 
Linux, UNIX, and Mac OS X systems as an alternative 
to X.
Remote desktop software is not suitable for situations 
in which multiple users need to run GUI applications 
such as Tecplot on the host system at the same time. In 
these situations, X is the preferred solution.
You may find performance better using remote desktop 
software instead of X. In our tests, the HP Remote 
Graphics Software was generally the most performant 
such solution when one or the other systems was Linux 
or UNIX-based. If both systems are Windows-based, 
ThinAnywhere is a plug-in that can improve the 
remote performance of 3D applications over slow 
networks.

http://www.thinanywhere.com/pro3drdp.php4
http://www.thinanywhere.com/pro3drdp.php4
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Graphics Drivers
For best results, please make sure that you are using the 
latest graphics drivers compatible with your hardware and 
operating system. These can be obtained from your graphics 
adapter vendor’s Web site. Old versions may have issues 
with Tecplot 360, especially with larger data sets.

• NVIDIA: http://www.nvidia.com/Download/
index.aspx

• ATI: http://support.amd.com/us/gpudownload/Pages/
index.aspx

• Intel: http://downloadcenter.intel.com/Default.aspx

Bug Updates
•  CFD Analyzer Bugs Fixed

The CFD Analyzer offers improved stability and 
correctness of results, especially on multi-processor 
systems. Due to these improvements, some CFD 
operations in Tecplot 360 2011 may yield results 
different from the same operations in Tecplot 360 2010 
on such systems. When differences occur, the 2011 
results are correct.
One class of affected calculations is those that involve 
velocity gradients. Mac OS X systems were likely to 
improperly initialize these calculations, resulting in 
erroneous results. A second class of errors involved the 
use of a non-thread-safe library in a multithreaded 
fashion, which could result in crashes or incorrect 
results on multi-processor systems in calculations 
involving gradients when calculate-on-demand was 
active.
The functions affected were X, Y, and Z vorticity, 
vorticity magnitude, swirl, velocity cross vorticity 
magnitude, helicity, relative helicity, filtered relative 
helicity, shock, filtered shock, pressure gradient 
magnitude, density gradient magnitude, X, Y, and Z 

http://www.nvidia.com/Download/index.aspx
http://www.nvidia.com/Download/index.aspx
http://support.amd.com/us/gpudownload/Pages/index.aspx
http://support.amd.com/us/gpudownload/Pages/index.aspx
http://downloadcenter.intel.com/Default.aspx
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density gradient, shadowgraph, divergence of velocity, 
vorticity, velocity cross vorticity, and pressure gradient, 
density gradient, and velocity gradient.

For a list of bugs fixed in this release, visit:

http://download.tecplot.com/360/2011r2/bugs_fixed.html

For a list of current known bugs in this release, visit:

http://download.tecplot.com/360/2011r2/bugs.html

To receive updates about new issues discovered in Tecplot 
360, subscribe to the Technical Bulletins forum on Tecplot 
Talk: http://www.tecplottalk.com/

Platform-specific Issues
The following table outlines the support for various 
platform-specific features in Tecplot 360 2011.

Refer to the remainder of this section for issues specific to 
your operating system.

Linux Mac Windows UNIX

FLOW3D 
loader

Y N Y N

ABAQUS 
loader

N N Y N

TrueType/
Unicode

Y Y Y N

http://www.tecplottalk.com/
http://download.tecplot.com/360/2011r2/bugs_fixed.html
http://download.tecplot.com/360/2011r2/bugs.html
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32-bit
On 32-bit operating systems, the address space 
provided to applications is limited to 2-3 GB (the exact 
amount depends on which operating system you use). 
You must use the 64-bit version of Tecplot 360 on a 64-
bit OS to visualize solutions larger than this.

Windows
Please help us make Tecplot products better by 
submitting an electronic report to Microsoft in the 
event that Tecplot 360 terminates unexpectedly. All you 
need to do is click the Send Error Report button. We 
review these reports regularly and they often help us 
find and resolve issues. To review some of the issues 
we’ve solved thanks to crash reports from users like 
you, visit http://tecplottalk.com/viewforum.php?f=33

• Windows Vista™ and Windows 7 Users
Installation

• You must have administrator rights on your 
computer to install Tecplot 360.

Linux
• Temporary Directory

Tecplot 360 relies on being able to create temporary 
files in the system temporary directory. On Linux, this 
directory is /usr/tmp or /var/tmp by default. If this 
directory is not writable, you can override the default 
either by setting the TMPDIR environment variable in 
your profile or by setting the TEMPFILEPATH in the 
tecplot.cfg file.

The 32-bit version of Tecplot 360 is not supported on 
64-bit Windows platforms. If you have a 64-bit 
version of Windows, install the 64-bit version of 
Tecplot 360.
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• Menu Shortcuts
Menu shortcut keys will not work if the NUM LOCK is 
on. You may set the NUM LOCK to turn off 
automatically at boot in your computer’s BIOS.

• SELinux
SELinux (provided with some Linux distributions) 
adds an extra layer of security. If you see this error 
message:

.//bin/tecplot.shared: error while loading 
shared libraries: .//lib/libtec.so: cannot 
restore segment prot after reloc: 
Permission Denied

Enter these two commands (you will need the root 
password):

sudo chcon -c -v -R -u system_u -r object_r 
-t lib_t $TEC_360_2011R2/lib/

sudo chcon -t texrel_shlib_t 
$TEC_360_2011R2/lib/*

You can then run Tecplot 360 without disabling 
SELinux.

• Ubuntu®

Tecplot 360 2011 is supported only on LTS (Long Term 
Support) releases of Ubuntu.

• Red Hat Enterprise Linux 6
RHEL 6 does not include all the X font packages needed 
to display the Tecplot 360 user interface correctly. As a 
result, text may be cut off or may otherwise be 
displayed incorrectly in dialogs. We recommend that 
the following font packages be installed:
xorg-x11-fonts-75dpi.noarch
xorg-x11-fonts-100dpi.noarch
xorg-x11-fonts-Type1.noarch
xorg-x11-fonts-ISO8859-*

• Remote Display Issues
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If you have a Network or Site license, you can run 
Tecplot 360 on one computer and display it on a second 
computer (via an X server). However, if you are 
running the OpenGL version of Tecplot 360, the X 
server must have the GLX extensions. If you are 
working with a large grid file remotely, try using the -
mesa option to minimize the number of OpenGL 
commands sent across the network.
When displayed remotely, Tecplot 360 may exhibit 
substantially lower drawing speeds than when it is 
displayed locally, especially for text and geometries.

• Mesa Versions
Mesa, an OpenGL-equivalent graphics library, 
performs 3D rendering in software. It is typically used 
when hardware acceleration is unavailable or when 
working with remote display of large data.
The Mesa version of Tecplot 360 functions slower, 
especially for 3D plotting. If you must run the Mesa 
version and display remotely, you can speed up the 
rendering for XY Line and 2D plots by setting the 
environment variable below. On some machines, this 
may also improve the speed of 3D plotting that does 
not use translucency. (Mesa translucency performance 
is known to be very bad.)

export MESA_BACK_BUFFER=Pixmap

UNIX

Tecplot 360 does not support TrueType fonts or Unicode text 
entry on UNIX platforms (IBM AIX, Solaris, or HP/UX).

• IBM AIX
Tecplot 360 2011 requires AIX Technology Level 7 or 
later. You must install OpenGL yourself, as this is not 
part of a standard AIX install.
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Mac OS X
• Intel Support

If you have a Mac with an Intel Core processor (rather 
than a Core 2 or later processor), you cannot run the 64-
bit Mac version of Tecplot 360, even if setuptec 
recommends this version. Install the 32-bit version of 
Tecplot 360 instead. 
To determine the type of processor in your Mac, choose 
“About This Mac” from the Apple menu. If the 
processor field displays “Intel Core” or “Intel Core 
Duo”, you have a Core processor. If it displays “Intel 
Xeon” or “Intel Core 2 Duo”, you can run the 64-bit 
version of Tecplot 360.

• Remote Display and OpenGL Issues
In Mac OS X 10.6, the X11 server has a known bug with 
native (hardware-accelerated) OpenGL applications 
displaying remotely using the GLX protocol. This same 
bug  prevents Mac OS X 10.6 from running native 
OpenGL applications remotely and displaying locally 
using the GLX protocol. This problem has been 
duplicated with even the most basic OpenGL 
applications and OpenGL utilities. It has been logged 
with Apple as bug #6628702.
Tecplot 360 can use a Mac OS X 10.6 machine as a 
remote display, or as a remote server displaying to a 
Linux or Windows client running an X11 server, if 
software OpenGL drivers are used. Tecplot 360 will use 
software OpenGL drivers if the -mesa option is supplied 
on the command line when starting the application.

• Off-Screen Rendering
Due to a problem with the Mac X Server, using off-
screen rendering with OpenGL on a Mac may cause 
exported images to be all black. This is a known bug, 
#4889883, in Apple’s X11 server. For this reason, we 
have disabled off-screen rendering as the default for 
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Mac installations. Image exporting and copying to the 
clipboard are performed using on-screen rendering 
instead. 
Should you want to enable it (for example, for anti-
aliasing and variable resolution image buffering), 
please add the following line to your tecplot.cfg file:
$!INTERFACE USEOFFSCREENBITMAP = YES
Alternatively, you can use the "-mesa" option when 
launching Tecplot 360 to use the software-only 3D 
renderer. However, you will lose the benefits of 
hardware acceleration.

Enjoy Tecplot 360 2011 R2 and master the view!
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